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Thank You for Choosing Ross
You've made a great choice. We expect you will be very happy with your purchase of Ross Technology. 

Our mission is to:

1. Provide a Superior Customer Experience

• offer the best product quality and support

2. Make Cool Practical Technology

• develop great products that customers love

Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and 
empowers our employees. I hope you enjoy reading it below.

If anything at all with your Ross experience does not live up to your expectations be sure to reach out to 
us at solutions@rossvideo.com.

David Ross
CEO, Ross Video
dross@rossvideo.com

Ross Video Code of Ethics
Any company is the sum total of the people that make things happen. At Ross, our employees are a 
special group. Our employees truly care about doing a great job and delivering a high quality customer 
experience every day. This code of ethics hangs on the wall of all Ross Video locations to guide our 
behavior:

1. We will always act in our customers’ best interest.

2. We will do our best to understand our customers’ requirements.

3. We will not ship crap.

4. We will be great to work with.

5. We will do something extra for our customers, as an apology, when something big goes wrong and 
it's our fault.

6. We will keep our promises.

7. We will treat the competition with respect.

8. We will cooperate with and help other friendly companies.

9. We will go above and beyond in times of crisis. If there's no one to authorize the required action in 
times of company or customer crisis - do what you know in your heart is right. (You may rent 
helicopters if necessary.)
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Introduction
This guide covers the use of the MC1-MK. The following chapters are included:

• “Introduction” summarizes the guide and provides important conventions.

•  “Using DashBoard” provides information on how to launch DashBoard and access the MC1-MK interfaces.

• “On Air Control Overview” provides a basic introduction to the MC1-MK, including an overview of the 
different areas of the On Air Control interface.

• “Keying” provides a summary of the MC1-MK keying features.

• “Transitions” provides a summary of performing transitions in DashBoard.

• “Squeeze Effects” outlines the SqueezeBack feature of the MC1-MK.

• “Audio” outlines the audio features of the On Air Control interface.

• “Media File Management” provides information on managing the images and animations using the DashBoard 
options available for the MC1-MK.

• “DashBoard Menus” summarizes the menus and parameters of the card tabs in DashBoard.

• “Glossary” provides a list of terms used throughout this guide.

Related Publications

It is recommended to consult the following Ross documentation before installing and configuring your MC1-MK:

• DashBoard User Manual, Ross Part Number: 8351DR-004

• OGX-FR Series Frames User Manual, Ross Part Number 8322DR-204

• MC1-MK Operation Manual, Ross Part Number: MC1MKDR-004B

• MC1-DB-CLN Quick Start Guide, Ross Part Number: MC1DBCLNDR-002

• MFC-OG3 Series User Manual, Ross Part Number: 8300DR-004

• MUX-8258 (-A, -4C, -8C) User Manual, Ross Part Number: 8258DR-004

Documentation Conventions

Special text formats are used in this guide to identify parts of the user interface, text that a user must enter, or a 
sequence of menus and sub-menus that must be followed to reach a particular command.

Interface Elements

Bold text is used to identify a user interface element such as a dialog box, menu item, or button. For example:

In the Network tab, click Apply.

User Entered Text

Courier text is used to identify text that a user must enter. For example:

In the Language box, enter English.

Referenced Guides

Text set in bold and italic represent the titles of referenced guides, manuals, or documents. For example:

For more information, refer to the DashBoard User Manual.
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Menu Sequences

Menu arrows are used in procedures to identify a sequence of menu items that you must follow. For example, if a 
step reads “File > Save As,” you would click the File menu and then click Save As.

Important Instructions

Star icons are used to identify important instructions or features. For example:

 Contact your IT department before connecting to your facility network to ensure that there are no conflicts. They 
will provide you with an appropriate value for the IP Address, Subnet Mask, and Gateway for your device.

Contacting Technical Support

At Ross Video, we take pride in the quality of our products, but if problems occur, help is as close as the nearest 
telephone.

Our 24-hour Hot Line service ensures you have access to technical expertise around the clock. After-sales service 
and technical support is provided directly by Ross Video personnel. During business hours (Eastern Time), 
technical support personnel are available by telephone. After hours and on weekends, a direct emergency technical 
support phone line is available. If the technical support person who is on call does not answer this line immediately, 
a voice message can be left and the call will be returned shortly. This team of highly trained staff is available to 
react to any problem and to do whatever is necessary to ensure customer satisfaction.

• Technical Support: (+1) 613-652-4886

• After Hours Emergency: (+1) 613-349-0006

• E-mail: techsupport@rossvideo.com 

• Website: http://www.rossvideo.com 

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com
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Using DashBoard
Once you install the MC1-MK, you can access its interfaces in DashBoard. These interfaces provide options for 
configuring, monitoring, and operating your card in DashBoard.

Before You Begin

Ensure that:

• The openGear frame that houses the MC1-MK displays in the Basic Tree View of DashBoard.

• The MC1-MK displays as a sub-node in the openGear frame tree.

• Your facility IT Department provided the required network settings to be assigned to the MC1-MK.

• The DashBoard software is installed on a PC connected to your facility network. The DashBoard software and 
user manual are available from the Ross Video website.

Launching DashBoard

DashBoard must run on a computer that has a physical wired ethernet connection. Wireless connections do not 
allow device discovery.

For More Information on...

• downloading and installing the DashBoard client software, refer to the DashBoard User Manual.

• the MC1-MK interfaces in DashBoard, refer to the chapter .

To launch DashBoard

1. Ensure that you are running DashBoard software version 8.4.0 or higher.

2. Launch DashBoard by double-clicking its icon on your computer desktop.

Accessing the On Air Control Interface in DashBoard

This section outlines how to display the MC1-MK interfaces in the DashBoard window.

For More Information on...

• the tabs and menus in DashBoard, refer to the chapter .

To display the Global interface in DashBoard

1. Launch DashBoard.

2. In the Basic Tree View of DashBoard, locate the openGear frame the MC1-MK is installed in.

3. Expand the openGear frame node to display a list of sub-nodes.

 Each sub-node is a card installed in the specified slot of that frame.

4. Locate the MC1-MK node in the frame tree.

5. Expand the MC1-MK node.

6. To access the MC1-MK On Air Control Interface:

a. From the Tree View, expand the node for the MC1-MK you want to access.

b. Select the On Air Control node to display the interface in the right-half of DashBoard.
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To set the MC1-MK On Air Control interface to full-screen

1. Press Shift+F11 to display the interface in full-screen mode. You can also select Window > Full Screen from 
the DashBoard toolbar.

2. To exit out of full-screen mode, press Shift+F11 again.

To lock the MC1-MK interface

1. To lock the interface, select the Lock button located in the upper right corner of the On Air Control interface. 

2. To unlock the interface, use the provided Unlock spinner.
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On Air Control Overview
This chapter provides a basic introduction to the MC1-MK, including an overview of the different areas of the On 
Air Control interface, using the menu system, as well as a brief summary of how video is controlled by the 
MC1-MK.

Menu System Basics

The On Air Control interface enables you to set up and perform transitions, configure keyers, monitor and control 
audio levels. This section provides a brief overview of the controls available in this interface.

Figure 3.1  MC1-MK — On Air Control Interface

1. Channel Select Buttons 

This area includes buttons that allow you to toggle between multiple MC1-MK interfaces. Selecting a button 
displays the corresponding MC1-MK On Air Control interface in DashBoard. A lit button indicates that the 
corresponding On Air Control interface is the currently active one in DashBoard. The icons on these buttons can 
be changed as described in the MC1-MK Installation Guide.

By default, and after a factory default reset is performed, these buttons do not display an icon (the button faces 
are blank).

1) Channel Select Buttons 5) Crosspoint Buses 9) Automation Button

2) Setup Tabs 6) Transition Area 10)Program Audio Area

3) Audio Meters 7) Keyer Area 11) Lock Button

4) Timer Display 8) Fade to Black Button
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2. Setup Tabs 

The tabs located near the top left of the interface provide options for configuring the keyers, on-air controls, and 
selecting logo channel sources. Refer to the chapter “DashBoard Menus” on page 45 for a list of the tabs and 
parameters available.

3. Audio Meters 

The On Air Control interface displays an audio meter for the first eight audio channels of Program and Preset 
(note that display will not be real-time). The meter scale ranges from 0 to -120dBFS. Refer to the chapter 
“Audio” on page 31 for details.

4. Timer Display 

This display is a free running timer that counts to a maximum of 23:59:59 (hh:mm:ss) and can be reset to 
00:00:00 using the Reset button. 

5. Crosspoint Buses 

This area is used to select the video sources for each bus. Each crosspoint button will display the name of its 
source on the button face. The last button of the row is a Shift button, which provides access to 10 additional 
selectable crosspoints. The default bus mapping is outlined in the MC1-MK Installation Guide. The following 
buses are available:

› Program Bus — The Program Bus is used to select the video source that will show as the Background on the 
Program output. After performing a factory default reset, the first unshifted router source (Router 1) is 
selected on this bus.

› Preset Bus — The Preset Bus is used to select the video source that is visible on the Preview output. After 
performing a factory default reset, the second unshifted router source (Router 2) is selected on this bus.

6. Transition Area 

This area provides the options for selecting transition rates (slow, medium, fast), and type (take, fade-fade, 
take-fade, mix, fade-take, and SqueezeBack). Refer to the chapter “Transitions” on page 23 for details.

7. Keyer Area 

This area includes the four keyers of the MC1-MK and allows you to perform the key transitions. If you have the 
3G Video Mode enabled, only two keyers are available. Refer to the chapter “Keying” on page 19 for details. 

8. Fade to Black Button 

Use this button to fade the Program bus to black. The Fade to Black (FTB) rate is specified in the Home tab. 
After performing a factory default reset, this button is toggled off (unlit).

You can also disable this button using the option available in the Personality tab. Refer to the MC1-MK 
Installation Guide for details on configuring the option.

9. Automation Button 

Toggling this button on (button will be lit) allows an Automation System to control the MC1-MK. After 
performing a factory default reset, this button is toggled off (unlit).

10.Program Audio Area 

This area includes an audio fader that enables you to control the Program audio gain. The slider is set by default 
to 0 and has a range of -72 to +12dB. Use the Default button to reset the audio gain. You can also configure an 
option in the Personality tab to automatically reset the audio gain to 0dB after any Background transition. Refer 
to the MC1-MK Installation Guide for details on configuring the option. 

11.Lock Button 

Use this button to lock the interface so that users are locked-out of the interface. This prevents anyone from 
changing settings on this MC1-MK interface. To lock the interface, select the button. To unlock, use the provided 
Unlock rotary spinner.
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Switcher Basics

This section gives an overview of how video is controlled by the MC1-MK. This includes video sources, video 
layering, and preview. For information on setting up crosspoints and video inputs, refer to the MC1-MK 
Installation Guide.

Video Sources

The MC1-MK has access to two basic types of video sources: external and internal. All video sources can be 
assigned to video source (crosspoint) buttons. By pressing a crosspoint button on a bus, the video source assigned to 
that button is selected.

• External — External video sources come from SDI inputs on the rear module.

• Internal — Internal video sources come from internally generated video, such as any of the four internally 
generated Logo channels, or an internally generated black.

To select a video source on a bus, you must identify the bus you want to assign a video source to and then press the 
crosspoint button you want to select on that bus.

Video Layering

Key layering is fixed for the MC1-MK and starts with Background and proceeds to Keyer 4.

Figure 3.2  Video Layering

Video Preview

Video preview allows you to use an additional monitor to preview what the next shot is going to be. The Preset bus 
of MC1-MK shows what is selected for the next transition. This includes the keys and background video sources 
that will be on-air after the next transition.

Overlay

The overlay feature provides one layer of text, in real time, as a source for any Keyer. The text can be from an EAS 
or LTC source.

Multiple MC1-MK Operation

DashBoard enables you to have multiple On Air Control interfaces open with each interface for a specific MC1-MK 
Master Control Switcher. Refer to the MC1-MK Installation Guide for details on setting up multiple cards.

Channel Ganging

The MC1-MK can operate as either master or remote channel depending on the role assigned to it in the Remote 
Control tab of its Configuration interface.

Commands

The master MC1-MK passes all commands described in Table 3.1 to each remote MC1-MK with a valid 
connection to it.

For More Information on...

• assigning a role to your MC1-MK, refer to the MC1-MK Installation Guide.
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Table 3.1  Commands Sent

Command Type Notes

Effect Select Copies the same selected effect number to all remote 
MC1-MK.

Fade to Black (FTB) Sets the fade to black state of each remote MC1-MK to match 
the master MC1-MK state.

Program Bus All crosspoint selections are supported including hot-punch on 
the Program bus, arming/disarming the Preset bus and 
selecting the source for External Key.

Preset Bus

External Sources

Key # The user hot-punched any key on the Program bus of the 
master MC1-MK.

The user armed/disarmed a key on Preset bus.

Audio Over The user hot-punched the AUDIO OVER button on the master 
MC1-MK.

The user armed/disarmed the Audio Over state on the master 
MC1-MK.

Audio Gain The user reset the Audio Gain fader value to 0 on the master 
MC1-MK.

The user adjusted the Master Audio gain value.

Transition Type Sets the transition type of each remote MC1-MK to match the 
master MC1-MK.

Transition Rates The total time expected for the transition is sent to each remote 
MC1-MK, permitting them to convert to the appropriate 
number of frames (based on the video format they are using).

The On Air Control interface, of each remote MC1-MK, does 
not report the actual transition rate. 

BKGD Include Sets the state of Transition Include buttons of each remote 
MC1-MK to match the master MC1-MK state.

SQUEEZE Include

TAKE Sets the TAKE button state (MC1-PANEL-16 and the On Air 
Control interface).

Sets the Automation TAKE state (using the Automation 
transition rate).

EAS Audio Duck Level Sets the EAS audio levels during a voice over of each remote 
MC1-MK to match the master MC1-MK state.

EAS Audio Gain Level

Voice Over Duck Level Sets the Voice Over audio levels during a voice over of each 
remote MC1-MK to match the master MC1-MK state.

Voice Over Gain Level



MC1-MK Operation Guide (v11.0) On Air Control Overview • 17

Status

The Home tab of each MC1-MK reports its channel gang status. This information is displayed as read-only text on 
the same line as the EAS Status (located at the bottom of the Home tab).

Home Tab — Example of Channel Gang Status for a Remote Channel

This information is duplicated in the Channel Gang status tab located in the Configuration interface of the 
MC1-MK.

For More Information on...

• status messages on the Home tab, refer to Table 9.1.
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Keying
Keying is the term used to describe when you insert (or electronically cut) portions of one screen into another, or 
place titles over background images. Keys are made up of two basic components: an alpha (that cuts the hole in the 
background video), and a fill (that fills the hole with different video). This chapter provides a summary of the 
MC1-MK keying features. 

Keyers Overview

MC1-MK includes up to four high quality 3G/HD/SD-SDI video keyers.1 In addition to the external Key Video and 
Key Alpha source, there are also four internal static/animation playout channels. This enables the keying of external 
devices such as character generators, graphic systems and EAS devices into a program feed and/or keying with four 
internal logo channels. If you have the 3G Video Mode enabled, only two keyers and two logo channels are 
available.

The card offers full key control with shaped and unshaped keying, self key or auto key, with clip and gain control. 

Figure 4.1  Keyer Controls

1. Keyers Tab

Each keyer has a sub-tab that enables you to select video sources, key types, and adjust transparency, clip, and 
gain. The MC1-MK supports Auto Select and Self keys. The External sub-tab enables you to specify the router 
source that feeds input on the KEY VIDEO Input or KEY ALPHA Input used as the External source when 
configuring keyers. 

2. Logos Tab

Each logo channel has a sub-tab in the Logos tab that enables you to specify the media files the channel uses. 
Refer to the section “Loading Media Files” on page 40 for details.

1. Only two keyers (Key 1, Key 2) are available when 3G Video Mode is enabled.

1) Keyers Tab 3) Program Keyer Select Buttons

2) Logos Tab 4) Preset Keyer Select Buttons
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3. Program Keyer Select Buttons

When lit red, a button indicates that specific keyer is currently on-air on the Program bus. Selecting a button will 
immediately perform cuts on that keyer.

4. Preset Keyer Select Buttons

These buttons are used to choose which keyer is included in the next transition. Note that depending on a 
Personality tab setting, once a transition is performed, the buttons are no longer lit.

Key Types

The MC1-MK supports the following key types:

• Auto Select — An Auto Select Key uses two video signals: the Key Alpha is used to cut the hole in the video, 
and the Key Video is used to fill the hole. For external keying, the source on BNC 2 is the Key Video and the 
source on BNC 4 is the Key Alpha. For internal sources, the Key Video and Alpha are generated internally (BNC 
2 and BNC 4 are not used). The Key Alpha Type is automatically set to Shaped.

• Self — A Self Key uses only one video signal: the luminance (or brightness) of the Key Video is used as the Key 
Alpha. For external keying, the source on BNC 2 is used as the Key Video and the Key Alpha (BNC 4) is not 
used. For internal sources, the Key Video is internally supplied (BNC 2 nor BNC 4 are used). The Key Alpha 
Type is automatically set to Unshaped.

Key Alpha Types

You can specify a key alpha as one of the following:

• Unshaped (multiplicative keying) — With an Unshaped Key, the Key Alpha luminance value mixes linearly the 
Key Video with the Background. Shades of gray, in the Key Alpha, are translated into transparency levels, giving 
the key a soft edge. Self Keys are set to Unshaped by default.

• Shaped (additive keying) — With a Shaped Key, the Key Alpha cuts a hole in the Background based on the 
luminance value of the Key Alpha and adds the Key Video to the Background hole. Shaped Key alphas are 
sometimes used with Character Generators to cut very precise holes for the Key Video fill. Auto Select keys are 
set to Shaped by default.

Configuring a Key

The MC1-MK provides the ability to associate each keyer with the following sources: external key video/fill, or a 
logo channel. This section briefly describes how to set up Key Alphas, Auto Keys, and adjust the clip and gain 
values, and how to apply a box mask.

For More Information on...

• loading media files to logo channels, refer to the section “Loading Media Files” on page 40.

• performing transitions, refer to the section “Performing Transitions” on page 25.

Configuring Key Sources

You can assign any of the four logo channels or a router crosspoint as the source for a keyer. The specific router 
crosspoint assigned to the Key Video source can be selected using the options in the External tab. 

 Leave Logo 4 assigned to Key 4 to ensure that EAS text crawls output properly. If you have the 3G Video Mode 
enabled, EAS is automatically re-assigned to Logo 2.

To configure a key

1. Navigate to the On Air Control interface as outlined in “Accessing the On Air Control Interface in 
DashBoard” on page 11.

2. Select the Keyers tab.
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3. From the Keyers tab, select the tab for the key you wish to configure.

4. From the Keyer Source area, select the button for the video source you want to assign to the Keyer.

The button for the selected source is now lit.

 If you selected External, you may also need to specify the router crosspoint as outlined in the section “To specify 
a router crosspoint as the External Keyer source” below.

5. Toggle the Key Type button to set the Key Type to Auto Select or Self.

6. If required, toggle the Key Alpha Type button to set the Key Alpha Type to Unshaped or Shaped. 

7. Adjust the Clip and Gain values of the key using the corresponding sliders. 

 Ross Video strongly recommends leaving the Clip and Gain values at the default settings to avoid undesirable 
effects.

8. Use the Transparency slider to adjust the transparency level of the key.

9. Toggle the Key Invert button to specify whether the key is inverted.

To specify a router crosspoint as the External Keyer source

1. Navigate to the On Air Control interface as outlined in “Accessing the On Air Control Interface in 
DashBoard” on page 11.

2. Select the External Sources tab.

3. From the External Sources row, select the button for the router crosspoint you want to assign as the External 
source.

The button is now lit and this crosspoint will be used whenever External is selected as the source for any Keyer. 
The crosspoint is identified by the default name displayed on the button in the External sub-tab. 

For More Information on...

• changing the crosspoint naming and/or mapping, refer to the MC1-MK Installation Guide.
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Transitions
This chapter provides a summary of performing transitions in DashBoard. For information on performing 
SqueezeBack transitions, refer to the chapter “Squeeze Effects” on page 27.

Transition Area Overview

Transitions are used to change the background video and take keys on and off-air. A transition can include any 
combination of Background video, and keys. The BKGD A (Program) and BKGD B (Preset) inputs allows for 
background dissolves and V-Fades behind the external key source. 

Figure 5.1  Transition Area

1. Keyer Area

The Keyer Area enables you to add, or remove, keyers in transitions. This area includes the following controls:

› The top row of buttons, labeled Key 1-4, are used to perform cuts on the specified keyer directly on the 
Program Bus, without affecting their inclusion in the next transition. A lit button indicates that the specified 
keyer is currently on-air.

› The middle row displays thumbnails of the video source selected for that keyer when possible. Note that 
images are only provided for the internal logo sources and not for external router sources.

› The bottom row of buttons, labeled Key 1-4, are used to add, or remove, the specified keyer to the next 
transition. Selecting the button toggles the keyer on/off and selects/removes the keyer to the Preset Bus 
respectively. Once the transition is executed, and depending on a Personality tab setting, the button(s) are no 
longer lit in this row but are lit red in the top row.

1) Keyer Area 3) Transition Speed Buttons 5) SQUEEZE Button

2) Transition Type Buttons 4) BKGD Button 6) TAKE Button
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2. Transition Type Buttons

The following Transition Type buttons are available (from left to right):

›  (Cut) — Select this button to perform a cut transition from one source to the next or to cut to a squeeze 
effect. This type can be combined with a squeeze effect.

›  (V-Fade) — Select this button to perform a V-Fade transition from the Program source to Black to the 
Preset source. The MC1-MK fades down from one source to black and then transitions to the next source. 
During a hot-punch transition, the video performs a CUT while the audio performs a V-Fade. This type can be 
combined with a squeeze effect.

›  (Cut-Fade) — Select this button to perform a cut to black, then fade up to the next source. This type can be 
combined with a squeeze effect.

›  (Cross Fade) — Select this button to perform a gradual fade from one source to the next. The MC1-MK 
performs a cross fade between sources. Note that this button is selected after performing a factory default 
reset. This type can be combined with a squeeze effect.

›  (Fade-Cut) — Select this button to fade from one source to black and then cut to the next source. This type 
can be combined with a squeeze effect.

›  (SqueezeBack) — Select this button to perform a SqueezeBack effect by reducing the size of the video 
over time to the dimensions set in the Squeeze Effects tab. Unlike the above types, you may not change your 
background or keys on-air with this transition type. The corresponding buttons are grayed out.

3. Transition Speed Buttons

These buttons apply the rate (slow, medium, fast) to the next transition. The transition rates are specified in the 
Home tab. Note that the Slow button is selected after performing a factory default reset.

Note that if you are controlling the MC1-MK via Automation, and these buttons are not lit, the transition rate 
applied is set by the Automation command. If you wish to apply one of these rates, remember to select the 
required transition speed button before performing a transition (e.g. selecting TAKE).

4. BKGD Button

The BKGD Include button is used to add, or remove, the BKGD from the next transition. Toggling this button 
will immediately affect the Background video that is visible on the Preset output.

5. SQUEEZE Button

The SQUEEZE Include button is used to add or remove, the selected squeeze effect preset from the next 
transition. Toggling this button will immediately affect the video that is visible on the Preset output. You may not 
de-select this button if a squeeze effect is on-air. This can be done with a Squeeze transition to perform a 
SqueezeBack, or as part of another transition (Take, Mix, Fade-Fade).

6. TAKE Button

Selecting the TAKE button performs the transition between the sources and effects selected in the Program and 
Preset buses, using the specified Transition Type and Transition Speed. The button is labeled TAKE NEXT 
when Automation is configured and enabled (the ATMN button is toggled ON), and the Take Button on Panel 
setting is set to Take Next in the Personality tab.

For More Information on...

• the corresponding buttons in the Keyers Area, refer to the section “Keyers Overview” on page 19.

• the Take Button on Panel setting, refer to the MC1-MK Installation Guide.

• configuring remote control via an automation protocol, refer to the MC1-MK Installation Guide.
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Performing Transitions

You can perform transitions in one of the following manners: hot-punching a crosspoint on the Program bus, 
selecting a Keyer (1-4) button from the Keyer Area to transition a keyer on or off air, and using the options in the 
Transition Area to add elements to the transition.

To set the transition rate

1. Navigate to the On Air Control interface as outlined in “Accessing the On Air Control Interface in 
DashBoard” on page 11.

2. Select the Home tab.

3. Specify the rate, in number of frames, as required, in the Slow Rate, Medium Rate and Fast Rate fields. 

4. Set the Fade to Black transition rate using the FTB Rate field.

To perform a transition

1. Navigate to the On Air Control interface as outlined in “Accessing the On Air Control Interface in 
DashBoard” on page 11. 

2. In the Transition Area, select the elements you want to add to the next transition by selecting the BKGD 
button to add the Background video source, and the Key 1-4 buttons to add the required keyer(s).

3. On the Preset bus, select the video source you want to take on-air.

4. Select a Transition Speed button (Slow, Medium, or Fast).

5. Select a Transition Type button.

6. Select Take.

To perform a Fade to Black

The FTB button allows you to fade to black, where the Program bus is faded to black at the FTB rate, the audio goes 
to silence, and closed captioning information is not passed. The Fade to Black rate is set in the Home tab as 
outlined above. When the FTB button is selected, or lit, the MC1-MK performs an Auto transition to black. 
Selecting the FTB button does not affect EAS audio, however any EAS text will be removed from the output.

Transition Notes

Keep the following in mind when performing transitions:

• To allow for audio cross fading, a cut takes two frames. One frame is used for the audio fade down, the video is 
then cut, followed by the one frame audio fade up.

• The speed at which the Auto transition is performed, in number of frames, is determined by the setting (Slow, 
Medium, or Fast) in the Transition Rate area. Before proceeding, ensure the Transition Type is set to the 
desired type.

• When switching between router sources, there is an additional time after the (visible) transition, while the router 
sources are switched. If you see a glitch at the end of the transition, this indicates that the Delay setting in the 
Router setup tab is set too low.

• If a crosspoint or transition button is selected while a transition is in progress, the original transition continues as 
subsequent button presses are ignored (except the FTB button).

• Verify how the Toggle Program/Preset Bus and Disarm Preset Keyers options are configured in the Personality 
tab. Refer to the MC1-MK Installation Guide.
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Squeeze Effects
The MC1-MK can be used to perform on-air SqueezeBack transitions to reveal another video source or graphic. 
You can also transition to pre-squeezed effects with standard transitions, squeeze in any direction on either X or Y 
axis, or both. Four SqueezeBack presets are provided for quick effect recalls on the fly. This chapter outlines the 
SqueezeBack feature of the MC1-MK.

SqueezeBack Effects Controls

This section briefly outlines the elements of the On Air Control interface for the SqueezeBack Effects feature.

Figure 6.1  SqueezeBack Effects Controls

1. SqueezeBack Effects Tab

The SqueezeBack Effects tab provides a sub-tab for each of the four SqueezeBack presets, enabling you to 
customize each effect separately. From these sub-tabs you can specify the horizontal and vertical positions of the 
image on the screen, and the reveal source from the four logo channels or an external video source. Because the 
reveal source shares the same sources available to the keyers, we encourage users to avoid sharing a source 
between keyer and reveal operation.

2. Effect Select Area

This area includes the Effect # status field and an EFFECT SELECT button. The status field reports the last 
applied effect and whether it is on or off air, or currently on the Preset Bus.

While the squeeze effect is on air:

› the EFFECT SELECT button is locked. Even though you can still adjust the options in the SqueezeBack 
Effects tabs, we suggest not doing so since all effect changes are immediately applied.

› you are unable to change the background or keys with a transition. However, you can still hot-punch a source 
or key on the Program bus. However, hot-punching a source on the Program bus will take the squeeze effect 
off air. Hot-punching keys on/off will not take the squeeze effect off air.

› you can perform any hot-punch or TAKE transition inside of the squeeze effect.

4
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3. SqueezeBack Effect Transition Type Button

Selecting this button performs a SqueezeBack effect with the transition. You must pre-configure your 
SqueezeBack presets, then select the preset you want to apply to the transition before executing your transition. 

4. SQUEEZE Button

Selecting this button applies the squeeze effect (as specified using the EFFECT SELECT button) to the next 
transition. 

The SQUEEZE Include button is selected (lit) and locked out as long as the transition type is Squeeze. The 
SQUEEZE Include button is not unlocked until you select another transition type, at which time the previous 
state of SQUEEZE Include and BKGD Include buttons are restored.

You can de-select the SQUEEZE Include button while an effect is on air to perform transition inside the squeeze 
effect.

Working in 2D Space

In order to maximize the features of the SqueezeBack feature, it helps to have a basic understanding of 
two-dimensional (2D) space. Two axes (X and Y) are used to define 2D space. The position of an image on each of 
the two axes determines its location in 2D space.

• X — Refers to the horizontal (left-right) position of the image on the screen.

• Y — Refers to the vertical (up-down) position of the image on the screen.

Figure 6.2  Basics of 2D Space

Image Position in 2D Space

The center point of the screen is the center (zero) point. Each axis has a positive and negative region.

• Moving an image to the left of the center (or zero) point locates it in -X space.

• Moving an image to the right of the center locates it in +X space.

• Moving an image below the center point locates it in +Y space.

• Moving an image above the center point locates it in -Y space.

When working with images, keep in mind that the 2D space extends beyond the visible area of the screen. Images 
can be positioned and manipulated outside of the viewable area to create some interesting effects. For example, and 
image can be positioned in such a way that it appears to roll into view from a point outside the screen and roll out of 
view on the other side.

+X

-X

Center Point or Zero Point  

+Y

-Y

Y Axis

X Axis



MC1-MK Operation Guide (v11.0) Squeeze Effects • 29

Configuring a SqueezeBack Preset

This section outlines how to configure Preset Effect 1 in preparation of including it in a transition. The same 
procedure can be used to configure any of the effect presets for your MC1-MK. 

For More Information on...

• the menu options when configuring your SqueezeBack presets, refer to Table 9.4.

To configure an effect

1. Navigate to the On Air Control interface as outlined in “Accessing the On Air Control Interface in 
DashBoard” on page 11.

2. Select the SqueezeBack Effects tab.

3. Select the Effect 1 tab to configure the first effect.

4. To specify the position of the image in the viewing area of the screen:

a. Use the X Position slider to adjust the horizontal position of the image on the screen.

b. Use the Y Position slider to adjust the vertical position of the image on the screen.

5. To squeeze the image appearance:

a. Use the X Size slider to squeeze horizontally.

b. Use the Y Size slider to squeeze vertically.

6. Select the Lock Aspect Ratio check box to squeeze in both directions at the same time.

 You can reset the image to the default image settings by clicking Reset to Defaults.

7. In the Reveal Source area, select the video source the squeeze effect will reveal. 

Performing Transitions with SqueezeBack Presets

This section provides examples of performing transitions with SqueezeBack Presets. Your requirements may differ 
from what is presented here.

Notes on Performing Transitions with SqueezeBack Presets

Keep the following in mind when performing transitions with SqueezeBack presets:

• You can pre-define up to four different SqueezeBack Presets (Effects 1-4)

• A squeeze effect does not consume any existing keyers and you can specify any of the logo channels to use as a 
reveal source for that effect.

• When the video format is 480i 59.94, the Line 21 closed captioning is re-inserted from the video source into the 
output of the MC1-MK when the NTSC Pass Line 21 setting is enabled. Refer to the MC1-MK Installation 
Manual for details.

• Hot-punches on the Program bus can be performed within an on air squeeze effect. The hot-punch is carried out 
inside of the squeeze effect. The squeeze effect remains on air.

• Squeeze effect transitions are also supported under the Presmaster automation protocol. Refer to the MC1-MK 
Installation Guide for details on this protocol.

• You can also trigger a squeeze effect using a GPI trigger. Refer to the MC1-MK Installation Guide for setup 
details.

• You can configure a tally to raise when the reveal source is visible. This tally will be raised regardless of the 
configured source. This can be used in cases when a graphics station is providing the video and needs to know 
when to trigger the playing of an animation. Refer to the MC1-MK Installation Guide for setup details.



30 • Squeeze Effects MC1-MK Operation Guide (v11.0)

Previewing a Squeeze Effect

You can preview your Effect preset on the Preview monitor without affecting the Program bus. However, any time 
a squeeze effect is on air, the preview output is not scaled correctly.

To preview a squeeze effect

1. Set up your effect as outlined in the procedure “To configure an effect” on page 29.

2. Navigate to the On Air Control interface as outlined in “Accessing the On Air Control Interface in 
DashBoard” on page 11. 

3. Use the EFFECT SELECT button to specify the desired squeeze effect for the transition.

4. Select the SQUEEZE button.

Transitions with SqueezeBack

This section provides examples of executing transitions that include SqueezeBack Preset.

Basic Transition with a Squeeze Effect

Operation: This is a SqueezeBack transition.

1. Set up your effect using the tabs in the SqueezeBack Effects tab as outlined in the section “Performing 
Transitions with SqueezeBack Presets” on page 29.

2. Use the EFFECT SELECT button to specify the desired squeeze effect for the transition. This is the effect that 
you configured in step 1.

3. Select  in the Transition Type area.

The Effect # status field now indicates ON PST. You can preview the squeeze dimensions on your Preview 
monitor.

4. Select the SQUEEZE button.

5. Select TAKE.

Dissolve to a Static Squeeze Effect

Prerequisite: You have a pre-squeezed effect ready on Preview.

Description: When you select TAKE, the Program dissolves to the pre-squeezed effect. After you have set up the 
transition, and during the transition, the Preview monitor is scaled correctly.

Operation: 

1. Select the EFFECT SELECT button to specify the desired squeeze effect for the transition.

2. Select a dissolve transition type (Fade-Fade, Take-Fade).

3. Ensure the SQUEEZE button is selected.

The Preview monitor shows the squeeze effect.
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Audio
This chapter outlines the audio features of the On Air Control interface, using audio proc amps, mapping channels, 
applying audio profiles, and using voice overs.

Audio Interfaces

This section briefly summarizes the audio monitoring and controls available in the On Air Control interface for the 
MC1-MK.

Figure 7.1  On Air Control Interface — Audio

1. Voice Over Tab

This tab provides options for configuring the duck level and gain for the voice over output.

2. Audio Processing Tab

The MC1-MK provides the ability to adjust the gain or mute individually, each of the 16 embedded channels. 
You can sum every adjacent pair of audio groups with the first channel on the Odd Channel numbers (e.g. 
Channels 1 and 2, 3 and 4, 5 and 6 etc.). You can also recall audio profiles from this tab.

This tab also indicates the crosspoint button currently selected on the Preset bus. This information is displayed in 
blue text at the top of the tab contents. This information is useful when selecting audio profiles, allowing you to 
see which crosspoint the audio profile will apply to during the next transition.

3. Audio Shuffle Tab

The MC1-MK provides the flexibility to modify the map of embedded audio channels. This is useful when the 
incoming feed has multiple languages, with each language consisting of a channel pair. By mapping the 
channels, you ensure that the proper language makes it onto the Program air path, and that the other languages 
can be muted or removed from the air path. You can also recall audio profiles from this tab. Refer to “Audio 
Shuffling” on page 35 for details on using the options in this tab.

1) Voice Over Tab 3) Audio Shuffle Tab 5) AUDIO OVER Buttons

2) Audio Processing Tab 4) Audio Meters 6) Audio Fader Controls
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This tab also indicates the crosspoint button currently selected on the Preset bus. This information is displayed in 
blue text at the top of the tab contents. This information is useful when selecting audio profiles, allowing you to 
see which crosspoint the audio profile will apply to during the next transition.

4. Audio Meters

This area displays Preset and Program audio peak level measurements for your audio channels. Measurement 
units are in dBFS (decibel full scale) where 0dBFS is the maximum digital value. Each audio meter displays 
audio level information as illustrated in Figure 7.2.

Figure 7.2  Illustrative Example of Audio Level Information

5. AUDIO OVER Buttons

An AUDIO OVER button is included on each bus. Selecting the button in the PST bus includes the voice over 
channel in the next transition. You can also hot-punch the AUDIO OVER button in the Program bus.

6. Audio Fader Controls

Use the slider to apply an audio gain value on the Program and Preset bus. The gain range is -72dB to +12dB. 
Use the Reset Audio Gain button to set the gain value to 0.

Audio Overview

This section outlines the audio features such as gain and duck levels, channel mapping, applying audio proc amps, 
transitions, and audio profiles. The MC1-MK can be operated in one of two ways: normal Audio Follow Video 
(AFV) mode, or Override mode.

Audio Follow Video

The Audio Follow Video (AFV) mode is where an audio channel is taken to air when the video it is associated with 
is taken to air. The audio will follow the video on and off-air like this for transitions.

For example, there may be a number of camera setups in the studio, each on focusing on a different talent. When a 
particular camera is taken on-air, you also want the audio from the talent’s microphone to be taken on-air. When the 
camera is taken off-air, you also want the corresponding audio channel to be taken off-air. This is normal AFV 
mode operation.

Audio Overrides

The Override mode is when the normal AFV mode has been altered, either by changing the gain, taking more or 
fewer channels to air, or altering the channels that will be taken to air on the next transition. Overrides are also 
applied by selecting one of the audio profiles. 

For example, if you have an over the shoulder shot, the audio channels for both the talent and the key would be 
on-air as per normal AFV. If you transition to a shot with only a VTR clip, then the audio from the talent would be 
taken off-air. If you wanted both audio channels to remain, you would have to set up an audio profile by turning on 
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the audio crosspoint for the talent on the Preset bus. When you make the transition, the MC1-MK takes the video 
off-air, but keeps the audio on.

Gain and Duck Levels

When setting up the gain and duck levels, note that audio sources are layered with the EAS positioned downstream 
from the Voice Over channel. For example, applying a duck level when EAS is active, also applies that value to the 
Voice Over channel (if active) and the other incoming audio sources. That means when both Voice Over and EAS 
audio are in effect, it is possible to duck the incoming audio twice.

Figure 7.3  Audio Layering

Audio Shuffling

You can shuffle the 16 audio channels within the embedded Channels with no de-embedding required. This 
re-shuffle is invoked in real time except when that input is on-air (the setting will not be editable in this case). For 
the case where Preset follows Program, the audio map is editable but not applied on the Program bus until the TAKE 
button is selected.

Audio Processing

The MC1-MK provides the ability to adjust the gain, or mute, individually, each of the 16 embedded channels. The 
audio processing and shuffle settings are retained on a per crosspoint basis.

Audio Profiles

Each profile displays as a selectable button on the Audio Processing tab and Audio Shuffle tab of the On Air 
Control interface. Note that profiles do not capture the Voice Over or EAS settings. Selecting an audio profile 
applies the saved settings to the selected crosspoint on the next TAKE transition. 

 You can only recall audio profiles from the On Air Control interface. Saving audio settings to an audio profile is 
done via the Configuration interface. Refer to the MC1-MK Installation Guide for details.

For example, your incoming fee has multiple languages, with each language consisting of a channel pair. You can 
create one audio profile to ensure that the proper language makes it onto the Program air path, and that other 
languages are muted or removed from the path. 

Transitions

You can specify which audio groups are the output (by default all groups are included). During transitions, the 
audio ramps smoothly between Program and Preset sources, matching the video transition. All channels of enabled 
groups are processed.

Setting the Master Audio Level

The master audio level can be adjusted manually using the Audio Gain slider. This slider applies a gain (in dB), to 
the audio that is included with the output.

To set the Master Audio level

1. Navigate to the On Air Control interface as outlined in “Accessing the On Air Control Interface in 
DashBoard” on page 11.

2. Specify the audio gain value using the Audio Gain slider.
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 The numerical gain value may also be entered directly in the PGM Audio field. 

3. You can select the Reset Audio Gain button to set the audio gain to 0dB. This resets the gain preset back to 
1:1.

Audio Processing

The MC1-MK provides the ability to adjust the gain or mute, each of the 16 embedded channels individually. You 
can sum every adjacent pair of audio groups with the first channel on the Odd Channel numbers (e.g. Channels 1 
and 2, 3 and 4, 5 and 6 etc.). The settings on the Audio Processing tab are included when saving audio profiles.

 Changes made to settings on the Audio Processing tab do not take effect immediately. A TAKE transition must 
be made to apply the new settings.

To configure the audio proc amps

1. Navigate to the On Air Control interface as outlined in “Accessing the On Air Control Interface in 
DashBoard” on page 11.

2. Select the Audio Processing tab.
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3. To apply a gain to a channel, use the associated Ch # slider to select a value between -72dB and +12dB. Note 
that this does not affect the Audio Over gain levels.

4. To mute a channel, select the associated Mute button. When the button is red, the specified output channel is 
muted.

5. To sum the outputs of channel pairs within a group, select the Sum button for the channel pair. Note that both 
channels will carry the average of the two input channels (A+B/2).

6. To reset the parameters for the specified channel to the default values, select the associated Reset button.

7. If required, repeat steps 3 to 5 for each channel in the group. 

Audio Shuffling

The MC1-MK provides the flexibility to modify the map of audio channels inside the SDI bit stream. This is useful 
when the incoming feed has multiple languages, with each language consisting of a channel pair. By mapping the 
channels, you ensure that the proper language makes it onto the Program air path, and that the other languages can 
be muted or removed from the air path. Note that the settings on the Audio Shuffle tab are included when saving 
audio profiles.

 Changes made to settings on the Audio Shuffle tab do not take effect immediately. A TAKE transition must be 
made to apply the new settings.

To map the audio channels

1. Navigate to the On Air Control interface as outlined in “Accessing the On Air Control Interface in 
DashBoard” on page 11.

2. Select the Audio Shuffle tab.

3. Map a channel using the associated Channel # Source menu to select an audio source to include in the 
embedded audio output. 

 If the selected source is not present on the input video, silence is embedded.

4. To reset the settings of a group to pass the input channels to the output channels in a direct 1:1 configuration, 
click Pass for the specific group. 

 Clicking Pass resets all attributes of the group, including gain, invert, mute, and sum.

5. To pass all groups, click Pass in the All Groups area. 
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Performing Transitions

During all audio transitions, the MC1-MK keeps track of three separate levels for each audio channel, or group. 
These levels are as follows:

• Current — The Current level is the level of the channel, or group, that is currently on-air. 

• Preset — The Preset level is the level of the channel, or group, that takes effect during the next transition of the 
audio. This level can be adjusted using an audio profile.

• Default — The Default level is the level that the channel, or group, was set to originally. When you perform an 
Audio Reset (by clicking the Pass button for all groups or a specific group) all off-air audio channels will have 
their preset levels changed to the default level. This will not change the Preset levels for the audio channels that 
are on-air.

During an audio transition, the MC1-MK prepares to take the Preset audio channel to air as follows:

1. The MC1-MK checks for audio profiles that will turn the channels, or groups, off or on, depending on how they 
are set in the Preset Audio bus.

2. The MC1-MK performs the audio transition by fading the Preset channels to their Preset audio levels. These 
levels then become the Current audio levels for those channels, or groups.

3. The MC1-MK then saves the Current levels of the audio channels that were taken off-air at the Preset levels for 
those channels, or groups. These levels will be used as the Preset levels for the next transition.

Notes on Audio Transitions

Keep the following in mind when performing transitions including audio:

• A two-frame V-Fade is performed on the audio if a different source is hot-punched on the Program bus.

• Audio transitions are Mix or V-Fade (on video fade, and cuts). However, during cut transitions, the audio 
transition is a V-Fade.

• Depending on how the Reset Audio Gain feature is configured, the audio gain level may be reset to 0dB after a 
transition. Refer to the MC1-MK Installation Guide for details.

For More Information on...

• performing transitions, refer to “Performing Transitions” on page 25.

Using Audio Profiles

Each of the four audio profiles are defined using the Configuration interface and capture the settings specified in the 
Audio tabs of that interface. These profiles that can be recalled from the On Air Control interface via the top row of 
buttons on the Audio Processing tab and Audio Shuffle tab of the On Air Control interface. 

For More Information on...

• creating audio profiles, refer to the MC1-MK Installation Guide.

Recalling an Audio Profile

Recalling an audio profile does not affect the Voice Over or EAS settings.

To use an audio profile

1. Configure the audio profile as outlined in the MC1-MK Installation Guide.

2. On the Preset bus, select the crosspoint button for the source you wish to take to air. The button is now lit blue.

3. Select the Audio Processing tab or the Audio Shuffle tab to display the available profiles.
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4. Select the button for the audio profile that you want to use during the next transition. The profile settings are 
used until another profile is loaded, or the user changes any of the settings.

5. Select the TAKE button. 

The selected crosspoint is taken to air and the corresponding button is lit in the Program bus. The settings in the 
audio profile are applied only to this crosspoint during the transition.

6. To apply a different audio profile to the next transition, repeat steps 2 to 5.

EAS Audio

The MC1-MK supports embedding Emergency Alert (EAS) audio.

Setup

EAS audio channel selection is done via the Audio Over Selection tab in the Configuration interface. EAS audio 
will be mixed into the Program path on the stage just before the final fade to silence.

Duck/Gain Levels

When EAS is active, all audio channels on the Program shall be adjusted by a value specified on the Audio tab in 
the Configuration interface. The default is to reduce the gain by 10dB.

When using a Sage Digital ENDEC EAS, the MC1-MK reacts to the Sage Push To Talk (PTT) relay closure to 
activate audio voice over. While the PTT relay is closed, the MC1-MK applies the EAS Duck Level specified on the 
Sage EAS Setup tab to the incoming Program audio and performs a cut transition by mixing the incoming audio 
from the channel at a specified level.

Voice Overs

The MC1-MK enables flexible audio/voice over mixing with a variable program audio duck level, audio over gain 
control, and preset mixing with transition control.When Voice Over or EAS is active, all channels are mixed. If the 
source contains more audio channels that you want mixed, ensure to use the Mute setting for those channels. The 
Voice Over source is selected using the Audio Over Selection tab in the Configuration interface. A Voice Over can 
also be triggered using GPIs.

For More Information on...

• setting up GPIs, refer to the MC1-MK Installation Guide.

Setting the Voice Over Duck/Gain Level

You can adjust the duck and gain levels of the Voice Over channel.

 If both Voice Over and EAS audio is in effect, the MC1-MK ducks the incoming audio twice. The Voice Over 
duck/gain is set in the Voice Over tab of the On Air Control interface.
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To set the duck/gain level

1. Navigate to the On Air Control interface as outlined in “Accessing the On Air Control Interface in 
DashBoard” on page 11.

2. Select the Voice Over tab.

3. Use the Duck Level slider to apply a negative gain (in dB) to the Voice Over channel.

4. Use the Gain slider to apply a gain (in dB) to the Voice Over channel.

Including a Voice Over

The Voice Over feature is triggered on/off by pressing the AUDIO OVER button located on the On Air Interface. 
Once the button is selected (button is lit), the voice over will remain active until the button is selected again (button 
is unlit). 

For More Information on...

• selecting the source for your Voice Over, refer to the MC1-MK Installation Guide.

• the location of the AUDIO OVER button, refer to “Audio Interfaces” on page 31.



MC1-MK Operation Guide (v11.0) Media File Management • 39

Media File Management
DashBoard enables you to select and configure the four Logo channels in the MC1-MK. Each Logo channel has a 
sub-tab that enables you to assign a media file to the specified logo channel, view a thumbnail that represents the 
media file currently loaded, and adjust on-air properties. This chapter provides information on managing the images 
and animations using the DashBoard options available for the MC1-MK. 

Playout Memory

The actual number of uncompressed frames that fit into the playout memory of the MC1-MK depends on the DDR 
size for your card and the Enable 3G Video Mode selection on the Personality tab.

For More Information on...

• configuring the 3G Video Mode, refer to the MC1-MK Installation Guide.

3G Video Mode Disabled

When 3G Video Mode is disabled on the Personality tab, the 1080p video modes are not available. This section 
outlines the playout memory values, based on DDR size of the card, when 3G Video Mode is disabled.

Table 8.1 lists an estimation of how many uncompressed frames can fit into the playout memory of each card type. 

3G Video Mode Enabled

When 3G Video Mode is enabled on the Personality tab, the entire first half of the DDR is reserved and not 
available for logo storage and animations. This affects all video modes. This section outlines the playout memory 
values, based on DDR size of the card, when 3G Video Mode is enabled.

Table 8.2 lists an estimation of how many uncompressed frames can fit into the playout memory of the MC1-MK 
when operating with 3G Video Mode enabled.

Table 8.1  Full Frame Animation — 3G Mode Disabled

Format Image Size No Alpha With Alpha

MC1-MK

1080i 1920x1080 285 190

720p 1280x720 641 427

PAL 720x576 1426 950

NTSC 720x486 1690 1126

MC1-MK-4GB

1080i 1920x1080 576 384

720p 1280x720 1296 864

PAL 720x576 2882 1921

NTSC 720x486 3416 2277



40 • Media File Management MC1-MK Operation Guide (v11.0)

 

Loading Media Files

There are four Logo channels (Logos 1-4) into which you can load files from the CompactFlash® Card physically 
installed on the board. Depending on the model, each board has 2GB or 4GB of DDR playout memory.

Loading a Media File

From the Directory menu in the each Logo sub-tab, files may be loaded from the following:

• [PATTERNS] — A virtual directory containing timecode overlays and EAS text crawls. Refer to the section “To 
display timecode in a logo channel” on page 44 for information on loading timecode files.

• [RAM CACHE] — A virtual directory that displays media files that are already loaded in the playout memory. 
Selecting this directory enables you to quickly access a pre-loaded file from the memory.

• [ROOT] — This is the default directory and represents the top-most directory on the CompactFlash® Card. You 
can manage files on the CompactFlash Card using an FTP connection. Refer to the section “Managing Media 
Files” on page 41 for details.

• ross — This directory contains graphics used in the Basic Tree View, Channel Select buttons, and Home tab for 
the MC1-MK card. Refer to the MC1-MK Installation Guide for information on managing the icon images used 
by the Tree View node, Home tab, Channel Select buttons, and On Air Controls node for your MC1-MK.

• User created directories — A list of user-created directories using an FTP connection.

To load a media file into a Logo channel

 Very large files and animations may take several minutes to load.

1. From the Tree View, expand the node for the MC1-MK you wish to access.

2. Select the On Air Control node to display the interface in the right-half of DashBoard.

3. Select the Logos tab, then select the Logo sub-tab for the logo channel you want to load the media file for.

4. If files were added or re-named using an FTP connection, select Rescan to update the list of directories and 
filenames.

5. From the Directory menu, select the directory you wish to load a file from. When changing directories, it may 
take a few moments for the Filename list to be updated.

Table 8.2  Full Frame Animation — 3G Mode Enabled

Format Image Size No Alpha With Alpha

MC1-MK

1080i 1920x1080 194 129

1080p 1920x1080 194 129

720p 1280x720 436 291

PAL 720x576 970 647

NTSC 720x486 1150 767

MC1-MK-4GB

1080i 1920x1080 388 258

1080p 1920x1080 388 258

720p 1280x720 873 582

PAL 720x576 1941 1294

NTSC 720x486 2301 1534
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6. From the Filename menu, select the file.

 You can clear the Logo channel by selecting [NONE] from the Filename menu.

Managing Media Files

Media files, such as animations and still images, can be transferred to and from the CompactFlash Card using an 
FTP connection. Once transferred to the CompactFlash Card, you use the options in the Logos tab to load the files 
and assign them to a Logo channel. This section outlines the specifications for media files and provides general 
information on using the CompactFlash Card and an FTP connection.

For More Information on...

• assigning media files to Logo channels, refer to “Loading a Media File” on page 40.

Media File Notes

The following tips and restrictions apply when managing your media files:

• Media files, such as stills and animations, are transferred to and from the MC1-MK using FTP protocol. The 
media files are stored on a CompactFlash card that is installed on the MC1-MK.

• If you select an image size that is larger than the current video format, only a portion of the image will be visible.

• When a media file is loaded, metadata, such as X/Y position, is also loaded, if it exists. Otherwise, default values 
are used. For animations, parameters are recalled after the last frame is loaded. Metadata is stored with the image 
on the CompactFlash Card, and is therefore no affected by loading factory default values.

• When using Mac OS X™ to transfer files to the CompactFlash Card via an FTP server, you may only have 
read-only access. Refer to your Mac OS X™ documentation for details.

Image Specifications

Media files used on the MC1-MK must meet the specifications outlined in Table 8.3.

For More Information on...

• the specifications for the files located in the ross directory, refer to the MC1-MK Installation Guide.

File Naming Specifications

The name can contain letters, numbers, and spaces, but cannot contain symbols such as ! @ # & * ( ) ? / , ‘ “.

Animation consist of multiple files, each must be numbered in the sequence that it will play out. The following 
restrictions apply to file names for animations:

• Each file can use a minimum 3-digit number, including all the leading zeros. The numbering can start from any 
value.

Table 8.3  Media File Specifications

Parameter Specification

File Type BMP, GIF, JPEG, PNG, TGA

Compression compressed and uncompressed

Interlaced formats (1080i, 480i, 576i) Max. Image Width: 32,768 pixels

Max. Image Height: dependent on available memory

Progressive formats (720p) Max. Image Width: 65,536 pixels

Max. Image Height: dependent on available memory

Animation Maximum Length 10,000 frames
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• The file name must consist of: the characters that are constant for this animation sequence, followed by an 
underscore (_), followed by three or more digits, followed by a period, followed by the filename extension.

• Each file in the sequence must have the same numbering scheme.

• Files are loaded in numerical order.

The following is an example of a 10-frame animation using a typical numbering scheme:

• DTVB_000.tga

• DTVB_001.tga

• ...

• DTVB_009.tga

Connection using FTP

You can use an FTP connection to transfer media files to and from the CompactFlash Card of the MC1-MK. You 
can also use an FTP client to delete images on the CompactFlash Card and re-name images.

To access the MC1-MK via FTP you will need:

• the IP address from Config > Ethernet.

• to connect the MC1-MK to your facility network. Refer to the MC1-MK Installation Guide for connection 
details.

An FTP connection to the MC1-MK should be established by your IT department. The following information is 
required to create an FTP connection:

• User Name — user

• Password — password

Connection using RossLinq

RossLinq enables you to transfer still images directly from the XPression to a MC1-MK Logo channel. You can 
transfer files into any of the directories for any of the Logo channels on the card. There are four directories, each 
corresponding to a specific Logo channel on the card. The file can be a format as listed in Table 8.3. Note that the 
transfer of animations is not supported at this time.

 The RossLinq channel in XPression must be set as a passive FTP connection in order to set up communications 
between XPression and the MC1-MK. Refer to the XPression documentation for details.

To connect to the XPression via RossLinq, establish an FTP connection using the following information:

• IP Address — Refer to the Ethernet tab in the MC1-MK Configuration interface.

• User Name — xpression

• Password — password 

When using an EAS, Logo 4 channel is automatically reserved for the EAS use. Do not attempt to transfer files 
via RossLinq into Logo channel 4 when EAS is enabled.

CompactFlash® Card

The following tips and restrictions apply when using the CompactFlash Card:

• the CompactFlash Card must be installed on the MC1-MK before the card powers up and must remain inserted.

• the CompactFlash Card is 2GB or 4GB in size, the number of files you can store depends on the type of file 
(PNG, TGA, JPG). The CompactFlash Status field in the Hardware tab displays how much space is available 
on the CompactFlash Card.

• refer to the MC1-MK Release Notes for information on formatting the CompactFlash.
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Adjusting On-Air Properties

The Logos tab in DashBoard allows you to adjust the position and play modes of media files. The following 
features are supported:

• Auto Play — When set, the animation will play from the first frame when it is brought to air. When clear, 
bringing the animation to air does not affect playback.

• Looping — When set, the animation will cycle continuously (from the last frame back to the first) in an endless 
loop. When cleared, the animation plays once, and freezes on the last frame.

• Hold Time — When set, the animation will play, but before looping back (if looping is enabled), it pauses on the 
last frame, for the specified Hold Time (in frames).

Parameters that are adjusted are saved with the image/animation. When a logo/animation is subsequently re-loaded, 
these parameters are also recalled. However, if there are no saved parameters for a recalled logo/animation, then the 
parameters remain unchanged.

For More Information on...

• the Logos menu items, refer to Table 7.3.

To adjust the on-air properties of a media file

1. Load a media file as outlined in the section “Loading a Media File” on page 40.

2. Adjust the position of a still image in the viewing area of the screen using the X and Y Position sliders.

3. Adjust the characteristics of an animation using the Auto Play and Looping boxes.

4. Select how an image is displayed by selecting an option from the Play Mode menu.

 The Play Mode feature only applies to Interlaced video formats and has no effect when using Progressive video 
formats.

Displaying Timecode in a Logo Channel

The Logos and Keyers tabs in DashBoard enable you to assign an LTC input to a Logo channel, then assign that 
Logo channel to an output. This section summarizes the steps required to configure an output to display LTC text, 
and provides additional configuration information.

Configuration Notes

Keep the following in mind when configuring a Logo channel for displaying LTC on-screen:

• The Status field on the Logos tab indicates the dimensions of the timecode file in the number of pixels. Note that 
this value changes depending on the video format you are using.

• To assign the same LTC to multiple outputs, configure a Logo channel with the LTC and then assign that Logo 
channel to multiple key sources. 

For example, to assign LTC to the Logo 3 channel and then assign it to multiple outputs:

› Configure Logo 3 to display LTC.

› Select Logo 3 as the Keyer Source box for Key 1, Key 2, Key 3, and Key 4.

• Should you attempt to load the same LTC to a second Logo channel, an error occurs and a message is displayed 
in the Status field of the second Logos tab. 

• You can transition between the keys, or the Background when using an MC1-MK. This can be used to transition 
the LTC on and off air.
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Frame Count Range Overview

The timecode information displays on-screen in one of the following formats: 

The frame count range depends on the video format you are using:

• When using 480i 59.94Hz and 1080i 59.94Hz, the range is from 00 to 29.

• When using 576i 50Hz and 1080i 50Hz, the range is from 00 to 24.

• When using 1080pSF 23.98Hz and 1080pSF 24Hz, the range is from 00 to 23.

• When using 720p 50Hz, the range is from 00 to 49.

• When using 720p 59.94Hz, the range is from 00 to 59.

When using a progressive video format, the LTC standard only provides a count of every second frame, but the 
MC1-MK will increment and display the frame count on every frame.

To display timecode in a logo channel

1. Navigate to the On Air Control interface as outlined in “Accessing the On Air Control Interface in 
DashBoard” on page 11.

2. Select the Logos tab.

3. Select the sub-tab for the Logo channel you want to load the timecode file for.

4. Select a timecode file to load to the Logo channel as follows:

a. From the Directory menu, select [PATTERNS].

b. From the Filename menu, specify the display font size (e.g. Select Time code - small to display text in a 
small font size).

5. Select the Keyers tab.

6. Select the sub-tab for the Keyer you wish to use to display timecode.

7. Adjust the transparency and other on-air properties for the output as described in the section “Configuring a 
Key” on page 20. 

 It is recommended to set the Key Type to Auto Select and the Key Alpha to Unshaped. 

8. From the Keyer Source area, select the Logo channel to assign it to the output.

9. From the On Air Control interface, enable the Keyer which was configured in the previous steps.

10. To adjust the on-screen position of the timecode, return to the Logos tab and use the X and Y Position sliders.

--:--:--:-- This format is used when no LTC input signal is received.

HH:MM:SS:FF
This is the standard format. The timecode is displayed in Hours, 
Minutes, Seconds, and Frames. The drop-frames is not active.

HH:MM:SS;FF
This is the drop-frame format. The timecode is displayed in Hours, 
Minutes, Seconds, and Frames. The drop-frame is active.
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DashBoard Menus
This chapter briefly summarizes the On Air Control menus available in the DashBoard Control System for the 
MC1-MK. Default values are noted with an asterisk (*).

Home Tab

Table 9.1 summarizes the Home tab options available in DashBoard.

 
Table 9.1  Home Tab Options

Item Parameters Description

Transition Rates (frames)

Slow Rate 2 to 999a

a. The default is 60 frames (2 seconds) when using 59.94Hz formats. When using 50Hz formats, the default is 50 frames.

Defines the Slow Rate in frames

Med Rate 2 to 999b

b. The default is 30 frames (1 second) when using 59.94Hz formats. When using 50Hz formats, the default is 25 frames.

Defines the Medium Rate in frames

Fast Rate 2 to 999c

c. The default is 15 frames (0.5 second) when using 59.94Hz formats. When using 50Hz formats, the default is 12 frames.

Defines the Fast Rate in frames

FTB Rate 2 to 999d

d. The default is 30 frames (1 second) when using 59.94Hz formats. When using 50Hz formats, the default is 25 frames.

Defines the Fade to Black Rate in frames

Station Logo image Displays an image of the station logo (using the file: 
ross/station_logo_large.png)

EAS Status: ONe

e. Followed by color-coded text.

Indicates that an installed EAS is providing content to 
the MC1-MK text overlay; the text is displayed in this 
area when the EAS is active.

OFF Indicates that EAS content is not provided to the 
MC1-MK text overlay

Operating as Master - Not Connected Communication was lost between this MC1-MK and 
one of the MC1-MK that it controls. The master 
MC1-MK is attempting to re-establish communications 
with the slave(s).

Operating as Master - Remote Connected Communication is valid between this MC1-MK and the 
remote MC1-MK it controls

Operating as Master - # Remotes Connected Communication is valid between this MC1-MK and the 
indicated number of remote MC1-MK it controls

Operating as Remote - Not Connected to 
Master.

Communication was lost between this MC1-MK and 
the master MC1-MK controlling it. The master 
MC1-MK is attempting to re-establish connection with 
this MC1-MK.

Operating as Remote - Connected to Master. Communication is valid between this MC1-MK and the 
master MC1-MK controlling it
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Keyers Tabs

Table 9.2 summarizes the Keyers tab options available in DashBoard. Each key has a sub-tab to select which key is 
to be modified.

Table 9.2  Keyers Tab Items

Item Parameters Description

Key #a

a. If you have the 3G Video Mode enabled, only two keyers and two logo channels are available.

Transparency 0* to 100 Adjusts the transparency level of the key:

• 0 — The key is completely opaque; there is no 
difference between the original key and the key with 
the transparency effect applied to it.

• 100 — The key is completely transparent; the key is 
not visible on the screen.

Clip # Adjusts the clip values; default is 92% (the maximum 
luminance range not including Super White).

Gain 0 to 100 Adjusts the gain values; default is 50.

Key Type Auto Select* A Key which uses two video signals (Alpha and Fill); 
the Key Alpha Type is automatically set to Shaped. 

If you configure an internal Logo channel as Auto 
Select, the associated alpha signal is used.

Self A Key that uses the luminance values of the KEY 
VIDEO source for the alpha; the Key Alpha Type is 
automatically set to Unshaped.

If you configure an internal Logo channel as Self, the 
luminance value of the associated alpha is used.

Key Alpha Type Unshaped The card performs a multiplicative key. The Key Alpha 
luminance value mixes linearly the Key Video with the 
Background. Shades of gray, in the Key Alpha, are 
translated into transparency levels, giving the key a soft 
edge.

Shaped* The card performs an additive key. The Key Alpha cuts 
a hole in the BKGD and the Key Video is added to the 
BKGD. Shaped Key alphas are sometimes used with 
Character Generators to cut very precise holes for the 
Key Video fill.

Key Invert On Reverses the polarity of the Key Alpha. A Key Invert 
can be applied to any key type.

Off* The Key Alpha is not inverted

Default Make Linear Resets the clip and gain values to the default settings. 
The default setting for this is Cleared (unselected).

Keyer Sourceb

b. The default Keyer Source is as follows: Key 1 is Logo 1; Key 2 is Logo 2; Key 3 is Logo 3; Key 4 is Logo 4.

External Assigns the external key source as the keyer output. 
You will also need to configure the settings in the 
External Sources tab (Table 9.5).

Logo #c Assigns the selected Logo media file as the keyer 
output
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Logos Tabs

Table 9.3 summarizes the Logos tab options available in DashBoard. Each logo has a sub-tab to select which logo 
is to be modified. 

     

c. When using an EAS device, Logo 4 is automatically assigned to Key 4 for EAS text crawls. Therefore do not use Logo 4 
and Keyer 4 for any other purpose when EAS is enabled. If you have the 3G Video Mode enabled, Logo 2 and Keyer 2 are 
automatically assigned to EAS text crawls.

Table 9.3  Logos Tab Options

Item Parameters Description

Logo #a

Video Imageb Displays a 
thumbnail image

• Displays a small image that represents the currently 
loaded media file. For animations, the fifth frame is 
displayed.

• Only available when the card ethernet port is 
connected and properly configured

• A black box with text indicates that no image is 
currently loaded

Alpha Imagea Displays a 
thumbnail image

• Displays a small image that represents the Alpha 
channel of the currently loaded media file. For 
animations, the fifth frame is displayed.

• A blank area indicates that the current image has no 
alpha channel

File (read-only) xxx_####.yyy Indicates the full path of the currently loaded file 
where:

• xxx represents the file path

• #### represents the duration of the file if it is an 
animation

• yyy represents the file extension

Status (read-only) Loading frame X 
of Y

• Displays information about the channel in both the 
number of frames (integer), and in the number of 
seconds (fractional)

• Any errors during loading are also displayed

• When the file(s) have loaded, this field displays the 
dimensions of the image (e.g. 1920x1080)

Animation loaded 
(#)

Single image 
loaded (#)

Idle

Selected on (read-only) ### Indicates all the key(s), or backgrounds, that currently 
have the media file selected 

None

On Air (read-only) ### Indicates the on-air key(s), or backgrounds, that have 
this media file selected

Directory [PATTERNS] Provides a list of virtual files loaded in the card emory, 
such as timecode information

[RAM CACHE] • The field displays the directory the currently selected 
media file is located in

• Provides a list of all of the directories on the 
CompactFlash card

[ROOT]*

ross
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Filename [NONE]* Selecting this option clears the logo channel. 

This item is automatically selected, without clearing the 
channel, when the user switches to a new directory.

Filename # • Displays the name of the currently selected media file

• Animation filenames include an underscore followed 
by three or more digits. The number of frames, and 
duration in seconds, displays in brackets after the 
filename

• Updated when a new Directory is selected in the 
Directory menu

• Provides a list of all the media files in the currently 
selected directory. Animations are a single entry.

File List Rescan Pressing the button updates:

• the Directory menu options

• the Filename menu options

X Positionc ## to ##d • Adjusts the position of the image along the X-axis in 
number of pixels

• The range varies depending on the output video 
format

Y Positionb ## to ##c • Adjusts the position of the image along the Y-axis in 
number of pixels

• The range varies depending on the output video 
format

Play Mode Normal* The entire frame of the image is displayed

Swap Fields Field 1 and Field 2 of the image are swapped when they 
are displayed

Field 1 Only Field 1 of the image is displayed

Field 2 Only Field 2 of the image is displayed

Auto Playe Selected The animation automatically starts to play when it is 
taken on-air.

Cleared* The animation starts playing as soon as the animation is 
loaded to the bus

Loopingd Selected The animation starts over when it reaches the last frame 
of the animation

Cleared* The animation stops when it reaches the last frame of 
the animation

Hold Time #f The animation plays but before looping back (if looping 
is enabled), it pauses on the last frame, for the specified 
number of frames

a. If 3G Video Mode is enabled, only two logo channels are available.
b. Requires an ethernet connection and sufficient free space on the CompactFlash™ card.
c. These settings only apply when there is an image loaded in the Logo channel. When the channel is empty, these settings 

have no effect.
d. The default is 0, which represents the top-left corner of the active picture area.
e. This option is only applicable when an animation file is selected.
f. The default is 0.

Table 9.3  Logos Tab Options

Item Parameters Description
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SqueezeBack Effects Tabs

Table 9.4 summarizes the SqueezeBack Effects tab options available in DashBoard.  

External Sources Tab

Table 9.5 summarizes the External Sources tab options available in DashBoard.

Table 9.4  SqueezeBack Effects Tabs Options

Item Parameters Description

Effect #

Hide Effect Selected Enables the effect to be selected for a transition using 
the EFFECT SELECT button

Cleared* Disables the effect

X Position #a

a. The range is from -# to +#. The default value is 0% which positions the image at the center point of the visible area.

Adjusts the horizontal position of the image on the 
screen (in number of pixels)

Y Position #a Adjusts the vertical position of the image on the screen 
(number of lines)

X Size 0- #b

b. The default is 100%.

Squeezes the image horizontally (to the specified in 
number of pixels)

Y Size 0- #b Squeezes the image vertically (to the specified in 
number of lines)

Lock Aspect Ratio Selected* Locks the aspect ratio given the current X and Y size 
parameters. Changing one parameter will cause the 
other parameter to automatically change to maintain 
this ratio.

Cleared X and Y parameters are adjusted independently

Reveal Sourcec

c. If 3G Video Mode is enabled, only two logo channels are available.

External Specifies that a router source will be the video source to 
be revealed by the squeeze effect. You must also specify 
the router source using the options in the External 
Sources tab.

Logo #d

d. The default Reveal Source is as follows: Effect 1 defaults to Logo 1; Effect 2 to Logo 2; Effect 3 to Logo 3; Effect 4 to Logo 4.

Specifies the logo channel as the video source to be 
revealed by the squeeze effect

Reset to Defaults Returns all parameters on the SqueezeBack Effects tab 
to the factory default values

Table 9.5  External Sources Tab Items

Item Parameters Description

# Selecting a button sets that video source as the External 
source. This source can be used for a key or the reveal 
of a squeeze effect.

The default External Source for the External Key is the 
first unshifted router source. When operating in an 
MC1 Stand-alone setup, the default source depends on 
how you configured your crosspoints.

Shift Select this to shift the sources
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Voice Over Tab

Table 9.6 summarizes the Voice Over tab options available in DashBoard.

 

Audio Processing Tab

Table 9.7 summarizes the options in the Audio Processing sub-tabs available in DashBoard. Note that channels 1-8 
are available on the first sub-tab and channels 9-16 are on the second sub-tab.

 

Audio Shuffle Tab

Table 9.8 summarizes the Audio Shuffle tab options available in DashBoard.

 

Table 9.6  Voice Over Tabs Options

Item Parameters Description

Duck Level (dB) #a

a. The default is -10dB.

This ducks the Voice Over source and the input audio. 
The AUDIO OVER button is lit.

Gain (dB) #b

b. The default is 0dB.

This applies a gain to the Voice Over source and the 
input audio. The AUDIO OVER button is lit.

Table 9.7  Audio Processing Tabs Options

Item Parameters Description

Channel #

Load Profile # Applies the audio settings of the selected 
profile to the currently selected Preset 
crosspoint on the next transition

Reset Resets the parameters for the specified channel 
only to the default values

Mute When the button is red, the specified output 
channel is muted. The default is not selected.

Gain -72dB to +12dBa

a. The default value is 0.

• Adjusts the gain of the specified channel of 
audio

• Does not affect Audio Over gain levels

• Select 0 when using non-PCM audio data

Channel Pair Sum Sums the outputs of channel pairs 1 and 2, 3 
and 4 within a group.

Both channels will carry the average of the two 
input channels (A+B/2).

The default is not selected.

Table 9.8  Audio Shuffle Tabs Options

Item Parameters Description

Load Profile # Applies the audio settings of the selected profile to the 
currently selected Preset crosspoint on the next 
transition
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Channel Source - Group#

Channel # Group # Ch #*a Embeds the specified Group and Channel pair

#Hz Tone Embeds the selected test tone

#kHz Tone

Pass Resets the specified group settings to pass the default 
input channels to the output channels. The mute, gain, 
sum, and invert settings for the specific group are reset 
to the default values.

All Groups

Pass Resets all group settings to pass the default input 
channels to the output channels. The mute, gain, sum, 
and invert settings for all groups are reset to the default 
values.

a. Default is embedded 1:1 mapping (e.g. G1C1 OUT is mapped to G1C1 IN)

Table 9.8  Audio Shuffle Tabs Options

Item Parameters Description
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Glossary
The following terms are used throughout this guide:

Active image — the portion of the video picture area (production aperture) that is being utilized for output content. 
Active image excludes letterbox bars and pillarbox bars.

Auto Select Key — a key in which two video signals are required to insert the key. The Key Alpha is used to cut 
the hole in the video, and the Key Video is used to fill that hole.

Card — refers to all MC1-MK models unless otherwise noted.

DashBoard — the DashBoard Control System.

DTVCC captions — CEA-708 captions.

Frame — the openGear frame that houses the MC1-MK unless otherwise noted. 

HTTP — Direct Hypertext Transfer Protocol.

Input 1 — refers to SDI IN 1.

Input 2 — refers to SDI IN 2.

Input 3 — refers to SDI IN 3.

Input 4 — refers to SDI IN 4.

LTC — Linear Timecode.

MIB — management information base.

Network Controller Card — the MFC-OG3-N and any available options unless otherwise noted.

NTSC captions — the CEA-608-D: Line 21 Data Services captions.

openGear Frame — refers to the OG3-FR series and OGX-FR series frames unless otherwise noted. 

PAL — PAL-B and PAL-G unless otherwise noted.

Production aperture — the image lattice that represents the maximum possible image extent in a given standard 
(e.g. the full size of all active pixels and active lines). For example, the 1080i production aperture would be 
1920x1080.

Self Key — a key in which the luminance, or brightness, values of the key source is used as the alpha for hte key.

System— the mix of interconnected production and terminal equipment in your environment.

TCP — Transmission Control Protocol.

TTL — Time To Live.

MC1-MK — refers to the model that does not include discrete audio processing features.

UDC-8625A-A — refers to the model with discrete audio processing features and eight unbalanced AES I/O.

UDC-8625A-B — refers to the model with discrete audio processing features and eight balanced AES I/O.

MC1-MK series — refers to all models unless otherwise noted.

UDP — User Datagram Protocol.

User — the person who uses the MC1-MK.
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